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Section 7 Names
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.
When entering formulae or referring to any area in a workbook, it is usual to refer to a ‘range’. For example, B6 is a range
reference; B6:B10 is also a range reference. One problem with this sort of reference is that it is not very meaningful and
therefore easily forgettable. If you want to refer to a range several times in formulae or functions, you may find it necessary
to write it down, or select it, which often means wasting time scrolling around the workbook. Instead, Excel offers the
chance to name ranges in a workbook, and to use these names to select cells, refer to them in formulae or use them in
Database, Chart or Macro commands.

Rules When Naming Cells
Names are unique within a workbook and the names that you choose to use must adhere to certain rules.
The first character of a name must be a letter or an underscore character. Remaining characters in the name can be letters,
numbers, full stops, and underscore characters.
Names cannot be the same as a cell reference, such as Z$100 or R1C1.
Spaces are not allowed. Underscore characters and full stops may be used as word separators - for example, First.Quarter
or Sales_Tax.
A name can contain up to 255 characters.
Names can contain uppercase and lowercase letters. Microsoft Excel does not distinguish between uppercase and lowercase
characters in names. For example, if you have created the name Sales and then create another name called SALES in the
same workbook, the second name will replace the first one.
Names can refer to external cells or ranges (in other workbooks) and can even be used when those workbooks are not
open, although when the references are checked by excel on update errors will occur if they are not valid.
Name Box
The Name box is situated on the left-hand side of the Formula bar. You can use the Name box to set up names and move
to them.
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Define name
There are three ways to create names or define them the management of names will be found on the formulas
ribbon in the defined names group.

To define a name
 Method 1 (Define)
Mouse

a) Select the cell or cells you wish to name
b) Click the define name from the defined names group on the formulas ribbon. A dialog is
launched
c) In the New Name dialog box, in the Name box, type the name that you want to use for your reference.
Names can be up to 255 characters in length.
d) In the name box, enter the defined name that you want to create.
e) To specify the scope of the name, in the Scope drop-down list box, select Workbook, or the name of a
worksheet in the workbook.
f) You may enter a descriptive comment up to 255 characters. This is optional (see note)
g) If you had selected cells or ranges previous to opening the new name dialog then the cells or ranges
selected will be displayed in the refers to box
If you had not previously selected cells or ranges: Then In the Refers to box
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Enter a Cell reference. The current selection is entered by default. To enter other cell references

as an argument, click Collapse Dialog (which temporarily hides the dialog box), select the cells on the
worksheet, and then press Expand Dialog.
Constant Type an = (equal sign), followed by the constant value.

i)

j) Formula Type an = (equal sign) followed by the formula. To finish and return to the worksheet, click
OK.
If you save the workbook to Microsoft Office SharePoint Server 2007 Excel Services, and you specify one or more
parameters, the comment is used as a tooltip in the Parameters toolpane.
To make the New Name dialog box wider or longer, click and drag the grip handle at the bottom.
➢➢ Method 2 (Direct)
Mouse
a) Select the cell, range of cells, or nonadjacent selections (nonadjacent selection: A selection of two or more
cells or ranges that don’t touch each other. When plotting nonadjacent selections in a chart, make sure that
the combined selections form a rectangular shape.) that you want to name.
b) Click in the Name box at the left end of the formula bar(formula bar: A bar at the top of the Excel window
that you use to enter or edit values or formulas in cells or charts. Displays the constant value or formula
stored in the active cell.).
c) Type the name that you want to use to refer to your selection. Names can be up to 255 characters in length
and press RETURN.
You cannot name a cell while you are changing the contents of the cell.
➢➢ Method 3 (By Selection)
Mouse
We

will turn your CV into
an opportunity of a lifetime

a) You can convert existing row and column labels to names.
b) Select the range that you want to name, including the row or column labels.
c) On the Formulas tab, in the Defined Names group, click Create from Selection.
d) In the Create names from Selection dialog box, designate the location that contains the labels by
selecting the Top row, Left column, Bottom ROW or Right column check box.
e) Press enter.

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com

Download free eBooks at bookboon.com

11

Click on the ad to read more

Excel 2007 Introduction: Part II

Names

Selecting Names (Navigation)
Names have great uses as a navigation tool within a document and are very easy to use . You may have used large portions
of your spreadsheet to store data and with over 1,000,000 rows and 0ver 16,000 columns it would be tedious or near
impossible to move around to known areas without names.
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➢➢ To select names and navigate
Mouse
a) Click on drop down arrow to right of name box and click on the name you would like to navigate to
b) You will now be at that location with the named cells selected

Manage Names By Using The Name Manager.
Use the Name Manager Dialog box to work with all of the defined names and table names in the workbook. For
example, you may want to find names with errors, confirm the value and reference of a name, view or edit descriptive
comments, or determine the scope. You can also sort and filter the list of names, and easily add, change, or delete names
from one location.
➢➢ To use name manager
Mouse
i.

To open the Name Manager Dialog box, on the Formula tab, in the Defined Names group, click
Name Manager.
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View names
The Name Manager Dialog box displays the following information about each name in a list box:
Icon and Name defined name is indicated by a defined name icon.
A table name is indicated by a table name icon.
If you save the workbook to Microsoft Office SharePoint Server 2007 Excel Services, and you specify one or more
parameters, the comment is used as a tooltip in the Parameters toolpane.
You cannot use the Name Manager Dialog box while you are changing the contents of the cell.
The Name Manager Dialog box does not display names defined in Visual Basic for Applications (VBA), or hidden names
(the visible property of the name is set to “False”).
Resize columns
To automatically size the column to fit the largest value in that column, double-click the right side of the column header.
Sort names
To sort the list of names in ascending or descending order, alternately click the column header.
Filter names
Use the commands in the Filter drop-down list to quickly display a subset of names. Selecting each command toggles
the filter operation on or off, which makes it easy to combine or remove different filter operations to get the results that
you want.
To filter the list of names, do one or more of the following:
Select:
Names Scoped To Worksheet
Names Scoped To Workbook
Names with Errors
Names without Errors
Defined Names
Table Names

To:
Display only those names that are local to a worksheet.
Display only those names that are global to a workbook.
Display only those names with values that contain errors (such as #REF, #VALUE,
#NAME, and so on.)
Display only those names with values that do not contain errors.
Display only names defined by you or by Excel, such as a print area.
Display only table names.
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➢➢ To Change a name
Mouse
a) On the Formulas tab, in the Defined Names group, click Name Manager.
b) In the Name Manager Dialog box, click the name that you want to change, and then click Edit. You
can also double-click the name.
c) The Edit Name dialog box is displayed.
d) Type the new name for the reference in the Name box.
e) Change the reference in the Refers to box, and click OK.
In the Name Manager Dialog box, in the Refers to box, change the cell, formula or constant

f)

represented by the name.
To cancel unwanted or accidental changes, click Cancel, or press ESC.

g)

h) To save changes, click Commit , or press RETURN.
If you change a defined name or table name, all uses of that name in the workbook are also changed. The Close button
only closes the Name Manager Dialog box. It is not required to commit changes that have already been made.
➢➢ Delete one or more names
a) On the Formulas tab, in the Defined Names group, click Name Manager.
b) In the Name Manager Dialog box, click the name that you want to change.
c) To select a name, click it.
d) To select more than one name in a contiguous group, click and drag the names, or press [SHIFT][Click] for
each name in the group.

�e Graduate Programme
I joined MITAS because
and Geoscientists
e) To select more than one name in a non-contiguous group, press [CTRL][Click] for
forEngineers
each name
in the group.
I wanted real responsibili�
Maersk.com/Mitas
www.discovermitas.com
I joined
MITAS because
f) Click Delete. You can also
press DELETE.
I wanted
real responsibili�
g) Click OK to confirm the
deletion.

�
for Engin

M

The Close button only closes the Name Manager Dialog box. It is not required to commit changes that have already
been made.

Names In Functions

Month 16
constructing a function you can just refer to the name and even then remembering
is not necessary it can be
I was the
a name
construction
M
selected and used easily within your function or formula.
supervisor
ina cons
I was
the North Sea supe
advising and the N
Real work
he
helping
foremen advis
International
Internationa
al opportunities
�ree wo
work
or placements
ssolve
problems
Real work
he
helping
International
Internationa
al opportunities
�ree wo
work
or placements
ssolve p
Names in functions can be very useful because it saves you having to go and select large amounts of cells or ranges when
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➢➢ To use names in functions
a) Go to cell you wish to create formula in and type in the function you wish to start with
b) e.g. =sum(
c) On the Formulas tab, in the Defined Names group, click use in formula.
d) Select which named range you wish to use and click on it.
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Or
e) Press [F3], choose the name you require and click OK
f) The function will now contain the named range and will calculate using the range or ranges it refers to
g) Press enter. Or click on the green tick on the left of the formula bar.
You may wish to use other methods to create your function or formulae only one method is mentioned here but it is the
same method for using the named ranges

Paste List Of Names
You can use the Paste Names dialog to give you an index of all the names in your workbook. Excel will place this on the
workbook wherever the active cell is positioned.

 To paste a list of names:
Mouse

a) On the Formulas tab, in the Defined Names group, click use in formula.
b) Click on paste names a dialog box is launched
c) Select an individual name and click on ok for an individual paste.
Or
d) Click on paste names to have all names pasted into worksheet with their cell references
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Keyboard
a) Select a blank cell where you want the list of names to begin.
b) Press [F3] to access the Paste Names dialog.
c) Press [TAB] to jump to the Cancel button, then [TAB] again to select the Paste List button. The list will
appear on the worksheet.

When you choose a start cell for your pasted list, make sure there is not any data immediately below as it will get cleared
when you paste the list.

Intersecting Names
Where you have named both columns of cells and rows of cells in a table, all the values will belong to two ranges. You
can use both names in a formula to retrieve the value where they intersect.

➢➢ To display a value from intersecting range names:
Keyboard
a) Select the cell where you want to display the value.
b) Type an equals sign (=) to begin the formula then press [F3] to access the Paste Names dialog, select the
first name and press [RETURN].
c) Type a space. Press [F3] again and select the second name. Press [RETURN]. Press [RETURN] again to
complete the formula.
E.G.: To retrieve the red books target figure from the data shown in the diagram above, your formula would read:
=RED_BOOKS TARGET

Download free eBooks at bookboon.com

18

Click on the ad to read more

Excel 2007 Introduction: Part II

Working with

Multiple Sheet

Section 8	Working with Multiple
Sheets
8.1

Multiple Worksheets

When you create a new workbook, Excel gives you multiple pages within that workbook called worksheets. The number
of worksheets you get defaults to 3, but you can change that (see the section on customisation for more information).
The worksheets are useful when you want to store information under common column headings but need to split it up,
(for example by month, week or by department).
When the same data needs to be entered on several worksheets, you can use Group mode which forces data that you type
on one worksheet appear on all selected sheets. When Group mode is active, any formatting that you apply to the active
worksheet also gets applied to the selected sheets.

Download free eBooks at bookboon.com
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Moving Between The Workbook Sheets
Each new workbook contains worksheets, named sheets 1 to sheet 3. The sheet name appears on a tab at the bottom of
the workbook window.

➢➢ To move between worksheets:
Mouse
a) Click on the appropriate tab
If the sheet required is not in view, use the tab scrolling buttons to display the sheet.
Or
Keyboard
a) Press [CTRL][PAGE DOWN] to move to the next sheet, or [CTRL][PAGE UP] to move to the previous
sheet.

Worksheet Names
Excel assigns the names “Sheet 1, Sheet 2” and so on to worksheets in a workbook but you can overwrite them with more
meaningful names to describe the data they contain.
➢➢ To rename a worksheet:
Mouse
a) Double-click the sheet tab that you want to rename – the current name will become highlighted.
b) Type the name you want.
c) Press [RETURN].

Worksheet names can be a maximum of 31 characters.
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Move And Copy Worksheets
Having named your sheets, you may need to switch them about so they are arranged in a different order.
➢➢ To move a sheet:

Mouse
i.

Click and drag the sheet tab left or right. You’ll see a page which follows your mouse pointer as you drag and
a black marker arrow to show where the sheet will jump to if you release the mouse.

i.

Release the mouse when the sheet is in the correct position.

➢➢ To copy a worksheet:

Mouse
a) Hold down the [CTRL] key then click and drag the sheet tab.
b) When the black arrow marker indicates the position that you want the copy, release the mouse then the
[CTRL] key.
Because no 2 worksheets can have the same name, when you copy a sheet as described above, Excel will suffix the copy’s
name with (2).

Insert And Delete Worksheets
You can add and remove worksheets to and from a workbook as required.
➢➢ To add a worksheet:
Mouse
a) Click on the last tab of the sheets this is a create new worksheet tab
b) Excel will name it initially with the next sequential number available.
Or
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Keyboard
a) Press [shift][f11]
b) A new sheet will appear the tab will be to the left of whichever sheet you are currently on and Excel will
name it initially with the next sequential number available.
➢➢ To delete a worksheet:
Mouse
a) Click the right mouse button over the worksheet that you want to delete.
b) Choose Delete from the shortcut menu. If there has been ANY work on the sheet to be deleted the
following dialog box will appear:
c) Click OK to confirm the deletion.
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Activate Group Mode

Whenever you select more than one worksheet, Excel considers those sheets to be grouped and switches group mode
on accordingly. When group mode is active, the grouped worksheet tabs turn white and the word “[group]” appears on
the title bar. Any data that you enter and any formatting that you apply will appear on all worksheets in the group in the
same positions on each – this is particularly useful if you need to create a “Summary” sheet that will reference the other
worksheets three dimensionally.

Group Adjacent Sheets
When the worksheets that you want to group are next to each other, you can use the [SHIFT] key to block select them.
➢➢ To group adjacent worksheets:

Mouse
a) Click the on the first worksheet’s tab that you want to include in your group.
b) Hold down the [SHIFT] key and click on the last worksheet’s tab that you want included in your group. All
the sheets between the first and the last will be selected. The selected sheet tabs will turn white and the word
“[group]” will appear on the title bar.

Group Non-Adjacent Sheets
When the sheets you want are not next to each other in the workbook, you can use the [CTRL] key to group them.
➢➢ To group non-adjacent worksheets:

Mouse
a) Click the on the first worksheet’s tab that you want to include in your group.
b) Hold down the [CTRL] key and click each other worksheet’s tab that you want included in your group. The
selected sheet tabs will turn white and the word “[group]” will appear on the title bar.
When worksheets are grouped, use normal data entry and formatting commands to populate them (see previous sections
for more information).
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Deactivate Group Mode
When you have finished entering and formatting data simultaneously, you can deactivate group mode. There are two
ways to do this:
➢➢ To deactivate group mode:
Mouse
a) Click on a sheet tab that is not currently grouped (non white).
Or
a) Click the right mouse button over any sheet tab and choose Ungroup Sheets from the shortcut menu.

8.3

Fill Data Across Worksheets

You can copy data to the same position on multiple sheets using the Fill command. This is particularly useful if you need
to decide what gets copied (everything, or just the formats). It also saves time for those occasions where you accidentally
deactivated group mode, typed your entries and then realised that they are only on one page!

Excellent Economics and Business programmes at:

“The perfect start
of a successful,
international career.”

➢➢ To fill across worksheets:
Mouse

CLICK HERE

to discover why both socially
and academically the University
of Groningen is one of the best

www.rug.nl/feb/education
a) Select the cells you want to copy to the other worksheet(s).

places for a student to be
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b) Select the worksheets you want the copy to appear on by clicking the sheet tabs (use [SHIFT] to block select
or [CTRL] to pick non-adjacent pages).
c)

On the Formulas tab, in the editing group, click the down arrow to the right of the fill icon.

d) Choose across worksheets
e) Choose the appropriate option and click OK.
When you have finished filling the data, remember to deactivate group mode!
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3-D Formulae
When you have data on multiple worksheets, you often want a summary page that will collect data from cells across all
the sheets and calculate it in a certain way. You can do this with a 3-D formula. 3-D formulae are no different from the
formulae already discussed in an earlier section of this manual, however, the way you refer to cells on different worksheets
has not yet been explored – that is what we will look at in this section.

External References
When you refer to a cell that is in another worksheet, Excel uses the following syntax:
Single cell
‘Worksheet name’![Cell reference]
In the diagram on previous page, cell D35 on the Summary sheet would be referenced as follows:
‘Summary’!D35
Cells on adjacent worksheets
1stWorksheet name:lastWorksheet name![Cell reference]
In the diagram on previous page, cell E32 across all staff would be referenced:
Conners:Pulaski!E32
Cells on non-adjacent worksheets
1st Worksheet name![Cell reference],2nd Worksheet name![Cell reference]
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In the diagram, cell D35 on Connor’s and Fuller’s sheets would be referenced:
Conners!D35,Fuller!D35
Luckily, because you can get Excel to put the references in automatically by pointing at the cells, you do not have to
memorise the syntax!

Commas separate up the references when selecting ranges or cells in this manner from different sheets
➢➢ To create a 3-D formula:
Mouse
a) Select the cell where you want the result.
b) Begin the formula by typing an equals sign (=), or select a function that you want to use.
c) When you need to enter cell references in your formula, move to the worksheet that contains the first cell
you want by clicking the relevant sheet tab.
d) Click on the cell whose value you want in your formula.
e) If you only need to refer to one cell, press [RETURN] to complete the formula.
Or
f) If you need to select the same cell on adjacent sheets, hold down the [SHIFT] key and click on the last sheet
tab in the block of adjacent sheets. Press [RETURN] to complete the formula.
Or
g) If you need to select the different cells on different sheets, type a comma and click the next sheet tab
and cell you need to reference, insert another comma and click the next sheet tab and cell you need to
reference and so on until all references have been entered. Press [RETURN] to complete the formula.

.
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Protect Worksheet Data

If you type in a cell that already has an entry, you overwrite that entry as soon as you press [RETURN]. Excel does have
an Undo facility, but if you need to delegate data entry to someone who is not too familiar with Excel, they could quite
feasibly end up overwriting your carefully constructed formulae. To prevent that happening, you can protect worksheets
in workbooks. Protected sheets can allow access to some cells but not others. Those that are unavailable cannot be edited,
formatted or cleared.

Unlock Cells
By default, all cells in a worksheet are locked. This does not have any effect on data entry and editing until you switch on
the worksheet protection at which point all locked cells are made unavailable. This means that if you want to have access
to certain cells, but not others, you need to unlock those cells first.
In the diagram below, you would need to unlock the selected cells so that when you protect the worksheet, those cells
are accessible.
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 To unlock cells:
Mouse
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a) Select the cells you want to be accessible when you protect the worksheet – you can select cells on multiple
sheets using group mode if necessary.
b)

Click the dialog box launcher. From either the font, alignment or number group on
the home ribbon

c) Click the Protection tab. And uncheck the Locked box.
d) Click OK to close the dialog and save the setting.
Or
a) Select the cells you want to be accessible when you protect the worksheet – you can select cells on multiple
sheets using group mode if necessary.
b) Click the format button in the cells group on the home ribbon. (See picture on previous page)
c) The lock cell button is already selected (all cells are locked by default). Click the lock cell button to
unlock the selected cells.

Worksheet Protection
➢➢ To protect a worksheet:
Mouse
a) Ensure that the sheet you want to protect is the active sheet.
b) Click the format button in the cells group on the home ribbon. (See picture on previous page). Click
on protect sheet. A dialog box is launched
c) Select from the checkboxes what you wish people be allowed to do (best left as default) Ticking the
Format Cells option would then allow all users to change the formatting of cells (locked or unlocked)
while still preventing them from changing the actual contents of the locked cells.

Join the best at
the Maastricht University
School of Business and
Economics!

Top master’s programmes
• 3
 3rd place Financial Times worldwide ranking: MSc
International Business
• 1st place: MSc International Business
• 1st place: MSc Financial Economics
• 2nd place: MSc Management of Learning
• 2nd place: MSc Economics
• 2nd place: MSc Econometrics and Operations Research
• 2nd place: MSc Global Supply Chain Management and
Change
Sources: Keuzegids Master ranking 2013; Elsevier ‘Beste Studies’ ranking 2012;
Financial Times Global Masters in Management ranking 2012

d)

Maastricht
University is
the best specialist
university in
Type a password to prevent unauthorized users from removing sheet protection. A password
is the
case
Netherlands
sensitive, can be up to 255 characters long, and can contain any combination of letters, numbers,
(Elsevier) and

Visit us and find out why we are the best!
Master’s
symbols. Open Day: 22 February 2014

e) Click OK to close the dialog and switch on sheet protection.

www.mastersopenday.nl
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Record all passwords somewhere as data can be lost If you cannot remember them With worksheet protection active,
only the unlocked cells are available to work with. If you try and type in a locked cell, the following warning appears:

Unprotect Sheets
If you do need access to the locked cells, you can switch worksheet protection off, provided you know the correct password.
➢➢ To switch off sheet protection:
Mouse
a) Select the protected sheet.
b) Click the format button in the cells group on the home ribbon. Click on unprotect sheet.
c) If you had a password then a dialog box will appear Type the password and click OK. The sheet is now
unprotected.
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Excel only lets you protect and unprotect sheets one at a time, that is to say, you cannot group all the sheets you want
to protect or unprotect and do it in one go.

View Worksheets Side By Side
You can display several worksheets in a workbook tiled in various ways on screen. These options can be found on the
view ribbon and the window group.

 To display worksheets side by side:
Mouse

a)

Go to the view ribbon and click on the side by side button a dialog is launched

b) Choose a file you wish to compare with and see side by side
c) Click ok

d) Repeat the above steps until you have a window for each worksheet.
e) On the view ribbon, click Arrange all. The Arrange Windows dialog box will appear:
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f) Choose the arrangement you want your worksheet windows to follow. Check the box Windows of
active workbook (this prevents windows from other open files being included in the arrangement).
g) Click OK to close the dialog and arrange the windows.
If your initial window is maximised, you do not see any change to the screen when you issue the New Window command,
you may not know how many windows you have. When you access the Window menu, the bottom section lists the
number of windows currently open.

> Apply now
Picture above shows tiled windows

redefine your future

AxA globAl grAduAte
allow simultaneous scrolling for all windows. If this feature does not help it can be switched
off.
progrAm
2014

When the windows are opened with the method mentioned previously, the button for synchronous scrolling will

- © Photononstop

Hide Windows
Whole windows can be hidden. Although you may need them open for calculations, macros, referred tables, etc you may
not wish to see them.
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 To hide a window
Mouse

a) Select the window you wish to hide
b) Go to the view ribbon and click the Hide button in the window group. The window is now hidden
➢➢ To unhide a window
Mouse
a) Go to the view ribbon and click the unHide button. In the window group a dialog is launched
b) Choose window to unhide and click OK. The window reappears.
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Watch Window
A watch window can be used to easily track results of multiple cells when you are working on a different sheet or workbook.
This saves you from having to switch back and forth or scroll between sheets to keep track of important data.
➢➢ To set a watch
Mouse
a) Select a cell to which you want to add a Watch
b) Go to the formulas ribbon an click on watch window in the formula auditing group
c) Click on add watch
d) Select cell you wish to monitor
e) Click on add
f) You may now switch windows or scroll and the watch window will monitor that cell for changes in result as
you enter or manipulate figures elsewhere.

➢➢ To delete a watch
Mouse
a) Go to the formulas ribbon an click on watch window in the formula auditing group
b) Select watch to delete
c) Click on delete watch on watch window
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Change Colour Of Worksheet Tab
➢➢ To change the colour of a worksheet tab:
a) Select the worksheet whose tab you want to re-colour.
b) Click the format button in the cells group, home ribbon and move your cursor down the menu to
tab colour.
c) Select the colour and click OK

Or
a) Right-click on the tab and choose the Tab Colour option.
b) Select the colour and click OK
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Section 9 Printing
When you want a hard copy of worksheet data, Excel gives you many tools for choosing how that printout will look.
Swapping the page orientation between portrait and landscape, scaling the size of the printout and choosing whether to
print worksheet gridlines are but a few of the options that can be set. Excel automatically assigns headers and footers to
your worksheet data, but you can change or enhance these very easily.
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Print Review

Before sending anything to print, it is always a good idea to preview what you will see on the page. The Print Preview
window will show how your data is going to print.

 To go to print preview
Mouse
a) Click the worksheet that you want to preview before you print it.
Click the Microsoft Office Button, click the arrow next to PRINT and then click Print

b)

Preview.
Or
Keyboard
a) Press [CTRL][F2]. On the Print Preview tab, do one or more of the following:
b) To preview the next and previous page, in the Preview group, click Next Page and Previous Page.
c) To view page margins, in the Preview group, select the Show Margins check box.
d) This displays the margins in the Print Preview view. To make changes to the margins, you can drag the
margins to the height and width that you want. You can also change the column widths by dragging handles
at top of print preview page.
To make page setup changes, on the Print Preview tab, in the Print group, click Page Setup, and then select the options
that you want on the Page, Margins, Header/Footer, or Sheet tab of the Page Setup dialog box.

9.2

Page Setup

When you want to alter headers and footers, orientation and so on, you use the Page Setup dialog box. There are four tabs
within this dialog, each give settings for one aspect of your printout. You can access the Page Setup dialog from either
the worksheet or the Print Preview window, however if you access it from the latter, some of the Sheet tab settings are
unavailable.
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page setup group on the page layout ribbon
 To access the page setup dialog:
Mouse
Click the dialog box launcher. From page setup group on the page layout ribbon

a)
Or

a) If you are in the Print Preview window, click the Page Setup button

Page tab
The Page tab allows you to set page orientation, scaling, paper size, print quality and a start number for page numbering.

Need help with your
dissertation?
Get in-depth feedback & advice from experts in your
topic area. Find out what you can do to improve
the quality of your dissertation!

Get Help Now
Orientation
Use this setting to swap between portrait and landscape printouts.
 To change page orientation:
Go to www.helpmyassignment.co.uk for more info
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Mouse
a) Access the Page Setup dialog and click the Page tab.
b) The default orientation is Portrait. Click Landscape to switch to printing on a landscape page.
c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new
settings will be displayed.
Or
a) Go to Page setup group on the layout ribbon and select orientation. Choose portrait or
landscape
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Scaling
You can manually scale the size of your printout by choosing a percentage amount you want to increase or decrease it
by. The Adjust to option reduces or enlarges the printed worksheet. The Fit to option will only reduce (not enlarge) the
worksheet or selection when you print so that it fits on the specified number of pages.

 To reduce or enlarge your printout:
Mouse
a) Access the Page Setup dialog and click the Page tab.
b) Select the Adjust to check box, and then enter a percentage number in the % normal size box. You can
reduce the worksheet to 10 percent of normal size or enlarge it to 400 percent of normal size.
c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.
 To fit your printout to a number of pages:
Mouse
a) Access the Page Setup dialog and click the Page tab.
b) Select the Fit to check box and then enter a number in the page(s) wide by box. If you want to limit
the number of pages tall, enter a number in the tall box.
c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.
Paper size
You can pick the size of the paper you want to print on by choosing from a list of pre-defined sizes.
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 To choose paper size:
Mouse
a) Access the Page Setup dialog and click the Page tab.
b) Click the drop-down list arrow to the right of the Paper Size box and click the paper size you want.
c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.

Or
a) Go to the page setup group on the layout ribbon and click on the size button to see many
predefined sizes to set your paper size to. If the size you wish is not available in the list. Then click on
more paper sizes at the bottom. This launchs the page setup dialog box
Print quality
You can enhance the quality of the printout if you need a pristine copy.
 To change print quality:
Mouse
a) Access the Page Setup dialog and click the Page tab.
b) Click the drop-down list arrow to the right of the Print Quality box and click the resolution you want
for the print quality of the active workbook.
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c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.

Resolution is the number of dots per linear inch (dpi) that appear on the printed page. Higher resolution produces better
quality printing in printers that support higher resolution printing.
Set first page number
If your printout is to form part of a larger document, you may need to change start number for pages.
 To change first page number: 
Mouse
a) Access the Page Setup dialog and click the Page tab.
b) Drag across the word Auto in the First page number box to select it. Type the number you want the
page numbering to begin at.
c) Click OK to close the dialog and save the setting – next time you access Print Preview, the new settings will
be displayed.

Brain power

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the
Margins Tab
world’s wind turbines.
Up to 25 % of the generating costs relate to mainteThe Margins tab lets you set top, bottom, left and right margins and centre
your data horizontally and vertically on
nance. These can be reduced dramatically thanks to our
systems
for page
on-lineyour
condition
monitoring
and automatic
page. You can also determine how far from the bottom and top edges
of the
headers
and footers
print.
lubrication. We help make it more economical to create
cleaner, cheaper energy out of thin air.
By sharing our experience, expertise, and creativity,
industries can boost performance beyond expectations.
Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge
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 To change margins:
Mouse

a) Access the Page Setup dialog and click the Margins tab. (above)
b) Use the up and down arrows in the Top, Bottom, Left and Right boxes to increase and decrease
margin measurements. The page sample in the middle of the dialog will update to show how your settings
will look should you choose to apply them.
c) Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.
Or
a) Go to the layout ribbon and the page setup group and click on margins a selection of quick
margin changes will be available including the last custom settings for a page
b) Click on a set of margins and they will be set.
 To change header and footer position:
Mouse
a) Access the Page Setup dialog and click the Margins tab.
b) Use the up and down arrows in the Header and Footer boxes to increase and decrease
the space between the header and footer and the top and bottom edges of the page.
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c) Click OK to close the dialog and save the settings – next time you access Print Preview, the new
settings will be displayed.
Centre on page
Use these check boxes to centre the data you are printing horizontally (between left and right margins) and/or vertically
(between top and bottom margins).

 To centre horizontally and vertically:
Mouse
a) Access the Page Setup dialog and click the Margins tab.
b) Click the Horizontally check box to centre between left and right margins. Click the Vertically
check box to centre between top and bottom margins.
3) Click OK to close the dialog and save the settings – next time you access Print Preview, the new
settings will be displayed.

Header/Footer Tab
Unless you specify otherwise, Excel uses the sheet name as the header for your printout and the page number as the
footer. You can choose from a predefined list of options for your header and footer, or for total flexibility, you can build
up the header and footer with codes that will generate dates, times, file names etc.
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Header
Excel’s default header is the sheet name. The Header box gives a list of options for you to use as your header. Excel
spaces items out in the header at the top left, middle and top right of the page. Where an option has commas separating
items Excel will interpret the comma as the spacing symbol.
➢➢ To change the header:
Mouse
a) Access the Page Setup dialog and click the Header/Footer tab.

Or
a) Click the drop-down list arrow to the right of the Header box to view a list of predefined headers and
click the one you want. The sample area will show you what your choice will look like.
b) Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.
Footer
Excel’s default footer is the page number. The Footer box, gives you the same options as the header box, but the position
of the chosen item will be at the bottom of the page. Excel spaces items out in the footer at the top left, middle and top
right of the page. Where an option has commas separating items Excel will interpret the comma as the spacing symbol.
➢➢ To change the footer:
a)

Click the dialog box launcher. From page setup group on the page layout ribbon,
select the header/footer tab ,

b) Click the drop-down list arrow to the right of the Footer box to view a list of predefined footers and click
the one you want.
c) Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.

New Methods For Headers And Footers In 2007
In Microsoft Office Excel, you can quickly add or change headers or footers to provide useful information in your worksheet
printouts. You can add predefined header and footer information or insert elements such as page numbers, the date and
time, and the file name.
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To define where in the printout the headers or footers should appear and how they should be scaled and aligned, you
can choose header and footer options.
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets (chart
sheet: A sheet in a workbook that contains only a chart. A chart sheet is beneficial when you want to view a chart or a
PivotChart report separately from worksheet data or a PivotTable report.), or for embedded charts (embedded chart: A
chart that is placed on a worksheet rather than on a separate chart sheet. Embedded charts are beneficial when you want
to view or print a chart or a PivotChart report with its source data or other information in a worksheet.), you can work
with headers and footers in the Page Setup dialog box.

Insert Specific Elements In A Header Or Footer
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets,
or for embedded charts, you can work with headers and footers in the Page Setup dialog box.
➢➢ Add or change the header or footer text for a worksheet in Page Layout view
Mouse

a) Click the worksheet to which you want to add headers or footers, or that contains headers or footers that
you want to change.
b) On the Insert tab, in the Text group, click Header & Footer.
c)

Excel displays the worksheet in Page Layout view. You can also click Page Layout View on the status
bar to display this view.
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d) To add a header or footer, click the left, center, or right header or footer text box
at the top or at the bottom of the worksheet page. And either:

e) Type the text that you want.
f) Insert a header or footer element if you from the header and footer elements group on the
design ribbon.
g) To change a header or footer, click the header or footer text box at the top or at the bottom
of the worksheet page that contains header or footer text, and then select the text that you want to change.
h) To start a new line in a header or footer text box, press RETURN.
i) To delete a portion of a header or footer, select the portion that you want to delete in the header
or footer text box, and then press DELETE or BACKSPACE. You can also click in the text and then press
BACKSPACE to delete the preceding characters.
j) To return to Normal view, click on the worksheet and then click on on the normal view button on
the View tab, in the workbook views group. You can also click Normal on the status bar.

To include a single ampersand (&) within the text of a header or footer, use two ampersands.
E.G., to include “Subcontractors & Services” in a header, type Subcontractors && Services.
k) To close the headers or footers, click anywhere in the worksheet, or press ESC.

Header Or Footer For A Chart
➢➢ Add or change the header or footer text for a chart
Mouse
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a) Click the chart sheet or embedded chart to which you want to add headers or footers, or that contains
headers or footers that you want to change.
b) On the Insert tab, in the Text group, click Header & Footer. Excel displays the Page Setup dialog
box.
c) Click Custom Header or Custom Footer.
d) Click in the Left section, Center section, or Right section box, and then click the buttons
to insert the header or footer information that you want in that section.
e) To add or change the header or footer text, type additional text or edit the existing text in the Left
section, Center section, or Right section box.
f) To start a new line in a section box, press RETURN.
g) To delete a portion of a header or footer, select the portion that you want to delete in the section box, and
then press DELETE or BACKSPACE. You can also click in the text and then press BACKSPACE to delete
the preceding characters.
To base a custom header or footer on an existing header or footer, click the header or footer in the Header or Footer box.
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Add A Predefined Header Or Footer
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets
or for embedded charts, you can work with the headers and footers in the Page Setup dialog box.
➢➢ Add a predefined header or footer to a worksheet in Page Layout view
Mouse

a) Click the worksheet to which you want to add a predefined header or footer.
b) On the Insert tab, in the Text group, click Header & Footer.
c)

Excel displays the worksheet in Page Layout view. You can also click Page Layout View on
the status bar to display this view.

d) Click the left, center, or right header or footer text box at the top or at the bottom of the worksheet page.
e) Clicking any text box selects the header or footer and displays the Header and Footer Tools, on
the Design tab.
f) On the Design tab, in the Header & Footer group, click Header or Footer, and then click the
predefined header or footer that you want.
g)

To return to Normal view, on the View tab, in the Workbook Views group, click Normal. You can
also click Normal on the status bar.

➢➢ Add a predefined header or footer to a chart
a) Click the chart sheet or embedded chart to which you want to add a predefined header or
footer.

b) On the Insert tab, in the Text group, click Header & Footer.
c) Click the predefined header or footer in the Header or Footer group.
d) Excel displays the Page Setup dialog box.
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Choose The Header And Footer Options
For worksheets, you can work with headers and footers in Page Layout view. For other sheet types, such as chart sheets
or for embedded charts you can work with headers and footers in the Page Setup dialog box.

➢➢ Choose the header and footer options for a worksheet
Mouse
a) Click the worksheet for which you want to choose header and footer options.
b) On the Insert tab, in the Text group, click Header & Footer.
c) Excel displays the worksheet in Page Layout view. You can also click Page Layout View on the status bar to
display this view.
d) Click the left, center, or right header or footer text box at the top or at the bottom of the worksheet
page.
e) Clicking any text box selects the header or footer and displays the Header and Footer Tools, adding the
Design tab.
f) On the Design tab, in the Options group, select one or more of the following:
g) To insert a different header or footer for odd pages on an odd page and for even pages on an even page,
select the Different Odd & Even Pages check box.
h) To remove headers and footers from the first printed page, select the Different First Page check box.
i) To use the same font size and scaling as the worksheet, select the Scale with Document check
box. To make the font size and scaling of the headers or footers independent of the worksheet scaling for a
consistent display on multiple pages, clear this check box.
j) To make sure that the header margin or footer margin is aligned with the left and right margins of the
worksheet, select the Align with Page Margins check box. To set the left and right margins of the
headers and footers to a specific value that is independent of the left and right margins of the worksheet,
clear this check box.
k) To return to Normal view, on the View tab, in the Workbook Views group, click Normal. You
can also click Normal on the status bar.
➢➢ Choose the header and footer options for a chart
Mouse
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a) Click the chart sheet or embedded chart to which you want to add a predefined header or footer.
b) On the Insert tab, in the Text group, click Header & Footer.
c) Excel displays the Page Setup dialog box.
d) To insert a different header or footer for odd pages on an odd page and for even pages on an even page,
select the Different Odd & Even Pages check box.
e) To remove headers and footers from the first printed page, select the Different First Page check box.
f) To use the same font size and scaling as the worksheet, select the Scale with Document check
box. To make the font size and scaling of the headers or footers independent of the worksheet scaling for a
consistent display on multiple pages, clear this check box.
g) To make sure that the header margin or footer margin is aligned with the left and right margins of the
worksheet, select the Align with Page Margins check box. To set the left and right margins of the
headers and footers to a specific value that is independent of the left and right margins of the worksheet,
clear this check box.
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Custom Header and Footer
If none of the predefined headers and footers are what you want, you can customise them using the Custom Header
and Custom Footer buttons. When you click either of these buttons, Excel gives you a dialog box representing either
the top (Custom Header) or bottom (Custom Footer) edge of your page.
You can type text into the left, centre and right sections, but if you want information to change dynamically according
to alterations you make to filenames, sheet names or you want to always display the current date and time in the header
(useful for seeing when a worksheet was printed),the dialog has buttons that generate codes. The codes instruct Excel to
include information where you have positioned them and will update if the information that they generate changes. The
diagram below details what each of the buttons do.

other header and footer settings

To insert a different header or footer for odd pages on an odd page and for even pages on an even page, select the
Different Odd & Even Pages check box.
To remove headers and footers from the first printed page, select the Different First Page check box.
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To use the same font size and scaling as the worksheet, select the Scale with Document check box. To make the
font size and scaling of the headers or footers independent of the worksheet scaling for a consistent display on multiple
pages, clear this check box.
To make sure that the header margin or footer margin is aligned with the left and right margins of the worksheet, select
the Align with Page Margins check box. To set the left and right margins of the headers and footers to a specific
value that is independent of the left and right margins of the worksheet, clear this check box.

Sheet Tab
The Sheet tab has many settings that you can use to select what appears on the printed sheet. You can also use this tab to
set a print area, (useful if you do not want the whole worksheet to print) and print titles.

www.sylvania.com
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Print Area
Use this to set the range of cells that you want to print. If you do not set a Print Area, Excel will print all the data on the
active worksheet.
➢➢ To set a Print Area:
Mouse
a)

Click the dialog box launcher From page setup group on the page layout ribbon,
select the sheet tab ,

Or
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a) Click on print area From page setup group on the page layout ribbon and select set print
area.
b) Click the button on the right of the Print Area box to collapse the Page Setup dialog so that you can
see the worksheet (see below):
c) Select the cells you want to print and click the Expand button to go back to the Page Setup dialog (see
below):
d) The selected cells will appear listed in the Print Area dialog. Click OK to close the dialog and save the
settings – next time you access Print Preview, the new settings will be displayed.

You can use the Set Print Area option to set the selected cells to the print area as an alternative to using the Page Setup
dialog.
 To clear the Print Area:
Mouse

a)

Click the dialog box launcher. From page setup group on the page layout ribbon,
select the sheet tab , Click in the Print Area, Delete the values.

Or
a) Click on print area From page setup group on the page layout ribbon and select clear
print area.
You can use the Set Print Area option to set the selected cells to the print area as an alternative to using the Page Setup
dialog.
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Print Titles
When your printouts run to several pages you may have column and row headings that you would like to print on each
new page. The diagram below shows a four page printout where the months have been set up to print at the top of each
page and the years at the left of each page. Excel allows you to specify any number of rows and columns to repeat when
you have a multi-page printout.

 To set print titles:
Mouse
i.

Access the Page Setup dialog and click the Sheet tab.

Or
a) Go to the page setup group on the page layout ribbon, and select the Print titles button. This
will open the page setup dialog box at the sheet tab

CHALLENGING PERSPECTIVES

b) Click the button on the right of the Rows to repeat at top box to collapse the Page Setup dialog
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Europe’s largest defence and aerospace group. More than
Rows
at top
box.and Eurocopter, We welcome more than 5,000 interns every year across
140,000
peopleto
workrepeat
at Airbus, Astrium,
Cassidian
disciplines ranging from engineering, IT, procurement and
in 90 locations globally, to deliver some of the industry’s most
strategy, customer
support, marketing
and sales.
d)
Repeat steps (selecting columns not rows) as abovefinance,
for thetoColumns
to repeat
at left
box if
exciting projects.
Positions are available in France, Germany, Spain and the UK.

the

required.

An EADS internship offers the chance to use your theoretical
find out more and apply, visit www.jobs.eads.com. You can also
knowledge
it first-hand
real situations
and assignments
e)
Clickand
OKapply
to close
the todialog
and save
the settings –Tonext
time you access Print Preview, the new settings
during your studies. Given a high level of responsibility, plenty of
find out more on our EADS Careers Facebook page.

will

be displayed.
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Print
The settings here allow you to choose whether to print gridlines, row and column headings and so on. If you choose not
to print gridlines, Excel will print any borders you formatted your cells with the diagrams below illustrate some of the
effects of activating certain settings.
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 To change Sheet tab Print settings:

360°
thinking

.

Mouse
a) Access the Page Setup dialog and click the Sheet tab.

b) Check the boxes under the Print heading until you have the combination of settings that you require.
c) Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.

360°
thinking

Page Order

.

360°
thinking

When you have multiple pages to print, each with a printed page number, you can control the order that the data prints
on the pages using the Page Order settings.

.

Discover the truth at www.deloitte.ca/careers

The diagram below shows how pages will have different numbers according to which setting you choose.

© Deloitte & Touche LLP and affiliated entities.
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 To change page order:
Mouse
a) Access the Page Setup dialog and click the Sheet tab.
b) Click the option button in the Page Order section for the order you want the pages numbered.
c) Click OK to close the dialog and save the settings – next time you access Print Preview, the new settings will
be displayed.
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The Page Setup dialog saves print settings for the active sheet only. If you want several sheets to have the same print
settings, select them before you access the Page Setup dialog.

Page Breaks
If you do not get page breaks to fall where you want them with the scaling options, you can insert them manually. Excel
lets you put in both horizontal and vertical page breaks.

 To insert a horizontal page break:
Mouse
a) Select the cell in column A below where you want the page break.
b) Choose breaks from the page setup group on the layout ribbon then click Insert Page Break.
A dotted line will appear above the active cell – this represents the page break.
 To insert a vertical page break:
Mouse
a) Select the cell in row 1 to the right of where you want the page break.
b) Choose breaks from the page setup group on the layout ribbon then click Insert Page Break.
A dotted line will appear to the left of the active cell – this represents the page break.
If you insert a page break when you are not in either the first column or row, Excel will insert both a horizontal and
vertical page break above and to the left of the active cell position.
 To remove a page break:
Mouse
a) Select the cell immediately below and/or to the right of the page break.
b) Choose breaks from the page setup group on the layout ribbon then click remove Page Break.
The page break will be removed
c) If Reset All page breaks is selected then all page breaks will be removed
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If the Fit To option is active in the page setup dialog, you cannot set manual page breaks.

Print Data
Excel will print all data on the selected worksheet (unless you tell it otherwise by setting a Print Area). If you want to
print more than one worksheet, select the sheets you want first, before you click the Print button.

➢➢ To print the active worksheet:
Mouse

We
turn
your that
CVyouinto
a) will
Click
the worksheet
want to print.
anb) opportunity
ofOffice
a lifetime
Click the Microsoft
BUTTON, click the arrow next to PRINT and then click quick Print
this will send everything on the sheet directly to the printer.
Or
a)

Click the worksheet that you want to print.

b) Click the Microsoft Office BUTTON, click the arrow next to Print, and then click Print this
will Launch a dialog box with settings for printing
Or
Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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Keyboard
a) Press [CTRL][P]. The Print dialog will appear; press [RETURN] to confirm the settings and launch the
print. Excel will display a dialog telling you what is printing.
 To print a specific worksheet page or range of pages:
Mouse
a)

Click the worksheet that you want to print.

b) Click the Microsoft Office BUTTON, click the arrow next to Print, and then click Print this
will Launch a dialog box with settings for printing
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Or

Keyboard
a) Press [CTRL][P].
b) The following dialog box will appear:
c) In the Print Range section of the dialog, click the Pages option button. A cursor will appear in the
From box to the right.
d) Type in the page number that you want to start at in the From box and the end page number in the To
box. Click the OK button to launch the print.
 To print the entire workbook:
Mouse
a)

Click the Microsoft Office BUTTON, click the arrow next to Print, and then click Print
this will Launch a dialog box with settings for printing

Or
Keyboard
a) Press [CTRL][P].
b) Click the Entire workbook option button in the Print what section of the dialog.
c) Click OK to launch the print.
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➢➢ To print the selection:
Mouse
a) Select the cells you want to print.
b)

Click the Microsoft Office BUTTON, click the arrow next to Print, and then click Print
this will Launch a dialog box with settings for printing

c) Click the Selection option button in the Print What section of the dialog.
d) Click OK to launch the print.

Copies
By default, Excel will print one copy of the item you have sent to print. You can print multiple copies by changing the
Print dialog settings. When you print multiple copies of a document, Excel lets you choose whether the copies are collated
(Excel prints each whole document before it starts on the next copy) or uncollated (Excel prints however many copies
you have requested of each page).
➢➢ To print multiple copies:
Mouse
a)

Click the Microsoft Office BUTTON, click the arrow next to Print, and then click Print
this will Launch a dialog box with settings for printing

b) In the Copies section of the dialog, use the up and down arrows to the right of the Number of
copies text box to set the number of copies you require.
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I wanted real responsibili�
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c) Set the Collate check box by clicking in it to change the current setting.
d) Click OK to launch the print.
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Section 10	Manipulating Large
Worksheets
Split Screen
The visible worksheet area is relatively small. If the data you are working with spans a large number of columns and rows,
you may find it difficult to move and copy information between areas, or even to view data in non-adjacent columns or
rows on the same screen. Splitting the screen gives you the ability to scroll the data one side of the split independently of
the other side – so you could be viewing cells Z100 – AH116 on one side of your screen, and cells A1 – G16 on the other.
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➢➢ To split the screen horizontally:
Mouse
a) Position the mouse along the top edge of the upward pointing arrow at the top of the vertical scroll bar –
your pointer should display as shown in the diagram above.
b) Drag down – you will see a fuzzy line that follows your mouse down. Release the mouse when the line is at
the position you want to split the screen.
➢➢ To split the screen vertically:
Mouse
a) Position the mouse along the top edge of the upward pointing arrow at the right of the horizontal scroll bar
– your pointer should display as shown in the diagram on the previous page.
b) Drag left – you will see a fuzzy line that follows your mouse across. Release the mouse when the line is at
the position you want to split the screen.
c) When the screen is split, you get scroll bars in each horizontal or vertical section of your window which you
can use to move the display for just that section.
➢➢ To apply both splits at same time
Mouse
Go to the window group on the view ribbon and click on the split button

a)

b) Both horizontal and vertical splits will be applied at the same time. These can be adjusted by positioning the
mouse over one and dragging in the desired direction
➢➢ To remove a split:
Mouse
a) Position the mouse over the split.
b) Drag a split back up until it is flush with the column or row letters or numbers and release the mouse, Or
Double click on the split
Or
a)

Go to the window group on the view ribbon and click on the split button

Freeze Panes
When you want certain rows or columns to remain static on screen while you scroll down or across data on a worksheet,
you can use freeze panes.
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➢➢ To freeze panes:
Mouse

a) Select the cell below and to the right of the cells you want to freeze.
b) Go to the window group on the view ribbon and click on the freeze panes button
c) Make a selection
If you only want the freeze for rows, select the cell in column A below the rows you want to freeze. If you only want the
freeze for columns, select the cell in row 1 to the right of the columns you want to freeze.
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 To unfreeze panes:
Mouse

a) Go to the window group on the view ribbon and click on the freeze panes button
b) Select Unfreeze panes

Zoom
You can adjust the scale of the on-screen display with the Zoom command. Excel allows you to specify any percentage
between 1 and 100 for viewing on-screen data. If there is a particular range that you need to make visible on one screen
without scrolling, you can use the Fit selection option.

 To zoom screen display:
Mouse
a) In the bottom right hand corner of the screen click on the Plus or minus buttons to zoom in or out of
your spreadsheet
Or
a) Click on the percentage button on the bottom right hand corner of your screen and a dialog box will
open.
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either
a) Choose a percentage from the dialog box
b) Click OK to apply the zoom and close the dialog.
Or
a) Highlight the percentage figure currently displaying in the Custom Zoom text box and type the
figure you want to use.
b) Click OK to apply the zoom and close the dialog.
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Section 11	Sorting & Subtotalling
Data
11.1

Lists

Excel’s tabular layout makes it an ideal tool to use for managing lists of data. There are many commands that you can
use to manipulate list data, which are described in this section, however, before discussing those, it is worth reviewing
the best way to lay out a list in Excel.

Do
Make the first row of your list the column headings that describe the data.

Do Not
Use ambiguous words as column headings (e.g. SUM, SUBTOTAL) as Excel may confuse
them with functions or names that you have defined.
Use punctuation in column headings.
Leave a gap between the column headings and the first row of data.
Leave blank rows between list data.

11.2

Sorting List Data

Where you have lists with lots of columns and rows, you may need to sort by more than one column. For example the
list of orders below has been sorted by customer, within the customer grouping, you may want to sort by Product and
then by Salesperson.

Quick Sort
➢➢ To use a quick sort
Mouse
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a) Click in the column you wish to sort by
b) do not highlight any data
c) Go to the data ribbon and the sort & filter group.
d) Click on the quick sort buttons ascending

or descending

e) Data should now be sorted

Multi Level Sort
➢➢ To sort using the Sort dialog:
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Mouse
a) Click in the middle of the list you want to sort.
b) Go to the data ribbon and the sort & filter group. And click on the sort button
c) Excel recognises the column headings from your list and allows you to pick them from drop-down list boxes
in the dialog.
d) Choose the column you wish to sort by from the drop down box in the column section

e) If you have various formats on your cells you can sort on more than just the value click on drop down arrow
to see further options
f) Set Ascending or Descending order for the sort by clicking the relevant option.

g) Click on add level, level will be added to the main area
h) Repeat previous procedure to add more levels of sort
i) If you wish to change the order of sort. Select the level you wish to change and click on the movement
arrows to move level up or down
j) To remove a level select it and click on the delete level button it will be removed
k) Click OK to perform the sort.

11.3

Subtotals

Excel can automatically add subtotals to a list of data. Your subtotals can sum numeric data or find highest and lowest
values and averages. You can also count the number of rows in a group.
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Organising The List For Subtotals
When you issue the subtotals command, Excel will need to know where to add the subtotals in. In the example below,
if you wanted to see subtotals for the revenue generated per product, you would first need to sort the list into Product
order. Similarly, if you wanted to see how much each salesperson had sold; you would sort the list by Salesperson before
adding the subtotals in.
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➢➢ To add subtotals to a list:
Mouse

a) Once you have sorted the list, choose subtotals from the Outline group on the data ribbon. The
following dialog box will appear:
b) Click the drop-down list arrow to the right of the ‘at each change in’ box to display your column headings.
Pick the heading according to which column you have used to group the data.
c) Click the drop-down list arrow to the right of the Use function box to display a list of functions you can use
to summarise data in your list. Click the function that you want.
d) Use the scroll arrows in the Add subtotal to list to set which columns you want to add the subtotals to.
Check the box next to the column to subtotal. You can add subtotals to more than one column.
e) Set options for the new subtotals using the check boxes at the bottom of the dialog.
f) If you want each subtotalled group on a separate page, check Page Break between groups.
g) Summary below detail adds subtotals and an overall total below the groups of data rather than above.
h) Replace current subtotals ensures that the new subtotals overwrite any existing ones.
i) Click OK to apply the subtotals.
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Example:
 To insert the subtotals shown above:-

a) Sort the list by product. Choose Data ribbon, Subtotals.
b) At each change in Product, Use function Sum, Add subtotal to Total

Summarising A Subtotalled List
Once you have added subtotals to a list, Excel gives you tools for collapsing the list so that you only see the grand total or
subtotals. The outline symbols that appear to the left of the row numbers allow you to hide and show detail rows as needed.
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 To hide detail for a group:
Mouse
a) Click the minus symbol that appears to the left of the row number where the grand/subtotal sits. All
bracketed rows will be hidden.

You can see where the hidden rows are because the outline symbol displays a plus sign.
➢➢ To show detail for a group:
Mouse
a) Click the plus symbol that appears to the left of the row number where the grand total/subtotal sits. All
hidden rows will reappear.
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Show And Hide By Level
When you add subtotals to a list, Excel gives you an overall total and subtotals per groups of sorted data. In the outline,
Excel numbers these levels 1 for the grand total, 2 for the subtotals and 3 for the detail.
The numbers appear above the outline symbols and can be used to collapse and expand the rows by level.
➢➢ To show only an overall total:
Mouse

a) Click the button marked 1 above the outline symbols. To show only totals:
Mouse
a) Click the button marked 2 above the outline symbols.

➢➢ To show all:
Mouse
a) Click the button marked 3 above the outline symbols.
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Remove Subtotals
If you want to remove subtotals from a list, you can use the Remove subtotals command.
➢➢ To remove subtotals:
Mouse
a) Click in the list with the subtotals
b) Choose subtotals from the Data ribbon. From the resulting dialog box, click the Remove All button. Any
totals and outlines will disappear.
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Section 12 Customising Excel
12.1

Set Excel Options

Options are set very differently in Excel 2007

Click the Microsoft Office BUTTON, Click the excel options button to open the dialog box above
Popular
This sheet allows you to turn off the mini toolbar that appears whenever you right click on a cell or range plus other
basic options
You may put in a different username which by default is the logon for windows
Clicking the language settings button allows the setting of the default language not just for excel but for all the office
programmes
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You may change the deault number of sheets from three to whatever you wish the limitations of excel will be in the next
chapter
Editing custom lists for various usages such as drag fill, series and sorting can be done from this sheet
You may even change the colour scheme for excel windows (not dialog boxes)\

Excellent Economics and Business programmes at:

“The perfect start
of a successful,
This sheet allows the setting of options that changes the way excel will calculate your sheets and workbook
international career.”
Formulas Sheet

CLICK HERE

to discover why both socially
and academically the University
of Groningen is one of the best
places for a student to be

www.rug.nl/feb/education
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Proofing
It is here on the Proofing sheet that the spell-check and grammar options are set for excel.
It also has the options for the autoformatting and autocorrection of entered text

Save
Save is an important sheet since excel 2007 saves in a completely different file format this sheet gives global options on
what filetype to save the file as and where to save files by default.This sheet also has the autorecover options for where
and how your files will be autosaved should windows crash. This saves your work regularly and automatically and should
recover work should the worst happen.

Resources
This sheet is useful to get updates for office (you do need to be online) and to run the office diagnostics if you encounter
errors with the way office works (you will need your original installation disc)
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Advanced Options
These are all the options on the advanced sheet there are to many to go into but should be useful for reference
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Customise Quick Access Toolbar
This is the location where you are able to customise the quick access toolbar (above the office button) and add your
most often used buttons to it.
➢➢ To customise quick access toolbar
a) From the drop down arrow on the top left on the box you may choose which group of commands you may
wish to see.
b) Select the buttons on the left and click on the add button in the middle to move them to the toolbar.
c) If you make a mistake then select the button on the right and click remove.
d) Once all the buttons you want are on the right hand side click ok to finalise your choices and apply them.
e) You may click on rest at any time to return to the default quick access toolbar
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Excel 2007 specifications and limits
Worksheet and workbook specifications and limits

Feature

Maximum limit

Open workbooks

Limited by available memory and system
resources
1,048,576 rows by 16,384 columns
255 characters
409 points
1,026 horizontal and vertical
32,767 characters
255
Limited by available memory (default is
3 sheets)
16 million colours (32 bit with full access
to 24 bit colour spectrum)
Limited by available memory

Worksheet size
Column width
Row height
Page breaks
Total number of characters that a cell can contain
Characters in a header or footer
Sheets in a workbook
Colours in a workbook
Named views (view: A set of display and print settings that you can name
and apply to a workbook. You can create more than one view of the same
workbook without saving separate copies of the workbook.) in a workbook
Unique cell formats/cell styles
Fill styles
Line weight and styles
Unique font types
Number formats in a workbook

Names in a workbook
Windows in a workbook
Panes in a window
Linked sheets
Scenarios (scenario: A named set of input values that you can substitute in a
worksheet model.)
Changing cells in a scenario
Adjustable cells in Solver
Custom functions
Zoom range
Reports
Sort references
Undo levels
Fields in a data form
Workbook parameters
Filter drop-down lists
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64,000
32
16
1,024 global fonts available for use; 512
per workbook
Between 200 and 250, depending on the
language version of Excel that you have
installed
Limited by available memory
Limited by available memory
4
Limited by available memory
Limited by available memory; a summary
report shows only the first 251 scenarios
32
200
Limited by available memory
10 percent to 400 percent
Limited by available memory
64 in a single sort; unlimited when using
sequential sorts
100
32
255 parameters per workbook
10,000
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➢➢ Calculation specifications and limits
Feature
Number precision
Largest number allowed to be typed into a cell
Largest allowed positive number
Smallest allowed negative number
Smallest allowed positive number
Largest allowed negative number
Length of formula contents
Internal length of formula
Iterations
Worksheet arrays
Selected ranges
Arguments in a function
Nested levels of functions
User defined function categories
Number of available worksheet functions
Size of the operand stack
Cross-worksheet dependency

Maximum limit
15 digits
9.99999999999999E307
1.79769313486231E308
-2.2251E-308
2.229E-308
-1E-307
8,192 characters
16,384 bytes
32,767
Limited by available memory
2,048
255
64
255
341
1,024
64,000 worksheets that can refer to other
sheets
Limited by available memory
Limited by available memory
Limited by available memory
4 billion formulas that can depend on a
single cell
32,767
January 1, 1900 (January 1, 1904, if 1904
date system is used)
December 31, 9999
9999:59:59

Cross-worksheet array formula dependency
Area dependency
Area dependency per worksheet
Dependency on a single cell
Linked cell content length from closed workbooks
Earliest date allowed for calculation
Latest date allowed for calculation
Largest amount of time that can be entered

➢➢ Charting specifications and limits
Feature

Maximum limit

Charts linked to a worksheet
Worksheets referred to by a chart
Data series(Related data points that are plotted in a chart. Each data series in
a chart has a unique colour or pattern and is represented in the chart legend.
You can plot one or more data series in a chart. Pie charts have only one data
series.) in one chart
Data points (Individual values that are plotted in a chart. Related data points
make up a data series. Data points are represented by bars, columns, lines,
slices, dots, and other shapes. These shapes are called data markers.) in a data
series for 2-D charts
Data points in a data series for 3-D charts
Data points for all data series in one chart
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Limited by available memory
255
255

32,000

4,000
256,000

